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Baseband troubleshooting

Context
This section is intended to be a guide for localising and repairing electrical faults. The fault repairing is divided
into troubleshooting paths. The following main troubleshooting tree describes the different baseband
troubleshooting paths to be followed in fault situations.

Figure 1 Main troubleshooting tree
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Dead or jammed device troubleshooting
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General power checking troubleshooting
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Clocking troubleshooting
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OMAP1710 troubleshooting
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Figure 2 SysCLK from C7528 & C7531

Figure 3 SleepCLK from R7558
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Charging troubleshooting
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Battery current measuring fault troubleshooting
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Flash programming fault troubleshooting

Figure 4 Flash programming fault troubleshooting 1/2
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Figure 5 Flash programming fault troubleshooting 2/2
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Figure 6 Flashing pic 1. Take single trig measurement for the rise of the BSI signal.

Figure 7 Flashing pic 2. Take single trig measurement for the rise of the BSI signal.
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CMT SDRAM memory troubleshooting

Figure 8 CMT SDRAM CLK from pin J2806
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CMT NOR flash fault troubleshooting

Figure 9 NOR CLK from J2813

RM-84/99
BB Troubleshooting and Manual Tuning Guide Nokia Customer Care

Issue 1 Company Confidential Page 1–17
Copyright ©2005 Nokia. All Rights Reserved.

 



OMAP1710 memory troubleshooting
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Legend
Take single trig measurement on the falling edge of the CE signal (=J5001).

Figure 10 COMBO NAND in boot pic 1.
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Power key troubleshooting
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USB interface troubleshooting
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Figure 11 USB 1: D-TXD (POP-PORT pin6) and D+RXD (POP-PORT pin7) voltage levels when USB connected.

Figure 12 USB 2: Take single triggered measurement on the rising edge of the Helen usb0_txen (J4813) line.
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SIM card troubleshooting
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Legend
SIM CLK frequency = 3.2MHz (Take single triggered measurement in boot on the VSIM1 line).

Figure 13 SIM interface signals
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MMC troubleshooting
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Legend
Take singe trig measurement on the rising edge of the DAT signal.

Figure 14 MMC card initialization

Legend
Take single trig measurement on the rising edge of the DAT signal.

Figure 15 Data transfer

Keyboard troubleshooting

Context
There are two possible failure modes in the keyboard module:

• One or more keys can be stuck, so that the key does not react when a keydome is pressed. This kind of failure
is caused by mechanical reasons (dirt, rust).

• Malfunction of several keys at the same time; this happens when one or more rows or columns are failing
(shortcut or open connection). For a more detailed description of the keyboard and keymatrix, see section
Keyboard (Page ).

If the failure mode is not clear, start with the Keyboard Test in Phoenix.
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Slider switch troubleshooting
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FM radio troubleshooting

Certificate restoring for BB5.0 products

Context
After replacing a defective flash memory component in BB5.0 products, Certificate Restoring must be carried
out to make the phone functional again.
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Certificate restoring for BB5.0 products is basically the same process as IMEI / ESN Rebuild for DCT-4 generation
products.

All tunings (RF & Baseband, UI) must be done after replacing the flash IC.

The procedure for Certificate Restoring when Flash IC has been replaced:

• Flash the phone with the latest available software (Use FPS-8 or FPS-10, USB Flashing does not work for a
dead BB5.0 phone).

• Create a request file.
• Send the file to Nokia by e-mail.
• When you receive a reply from Nokia, carry out Certificate Restoring.
• Tune the phone completely (Note: SX-4 Smart Card is needed).
• If phone resets after a certificate restore, reflash the phone again.

Required equipment and setup:

• Phoenix service software v 2004.39.7.70 or newer.
• The latest phone model specific Phoenix data package.
• PKD-1 dongle
• SX-4 smart card (Enables BB5.0 testing and tuning features)
• External smart card reader (Only when FPS-8 is used, FPS-10 has an integrated smart card reader)
• Activated FPS-8 flash prommer OR FPS-10 flash prommer
• Flash update package 03.18.004 or newer for FPS-8 or FPS-10 flash prommers
• CU-4 control unit
• USB cable from PC USB Port to CU-4 control unit
• Phone model specific adapter for CU-4 control unit
• PCS-1 cable to power CU-4 from external power supply
• XCS-4 modular cable between flash prommer and CU-4

Note: CU-4 must be supplied with +12V from external power supply in all steps of Certificate Restoring.

Steps
1. Program the phone software.

i Start Phoenix and login. Make sure the connection has been managed correctly for FPS-8 or FPS-10.
ii Update the phone MCU software to the latest available version.

If the new flash is empty and the phone cannot communicate with Phoenix, the procedure in this case
is a “Dead Phone Flash” described below.

iii Choose the product manually from File →  Open Product , and click OK.

Wait for the phone type designator (e.g. “RM-1” ) to be displayed in the status bar.
iv Go to Flashing →  SW Update  and wait until Phoenix reads the product data as shown in the following

picture.
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Product is automatically set according to the phone support
module which was opened manually, but the flash
files cannot be found because the correct data cannot
be read from the phone automatically.

Code must be chosen manually, it determines the correct
flash files to be used. Please choose the correct product
code (can be seen in the phone type label) from the
dropdown list.

Flash Type must be set to Phone as Manufactured.

v To continue, click Start.

Progress bars and messages on the screen show actions during phone programming, please wait.
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Programming is completed when Flashing Completed message is displayed.

The product type designator and MCU SW version are displayed in the status bar.
vi Close the SW Update window and then choose File →  Close Product .

2. Create a Request file.

For this procedure, you must supply +12 V to CU-4 Control Unit from an external power supply.

i To connect the phone with Phoenix, choose File →  Scan Product .
ii Choose Tools →  Certificate Restore .
iii To choose a location for the request file to be saved, click Browse.
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iv Name the file so that you can easily identify it, and click Open.

The name of the file and its location are shown.

v To create the Request file, click Start.
vi When the file for Certificate Restore has been created, send it to Nokia as an e-mail attachment.

3. Restore Certificate.

For this procedure, you must supply +12 V to CU-4 Control Unit from an external power supply.

i Save the reply file sent by Nokia to your computer.
ii Start Phoenix service software.
iii Choose File →  Scan Product .
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iv From the Tools menu, choose Certificate Restore and select Process a response file in the Action pane.

v To choose the location where response file is saved, click Browse.
vi Click Open.

The name of the file and the path where it is located are shown.
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vii To write the file to phone, click Start.

Next action
After a successful rewrite, you must retune the phone completely by using Phoenix tuning functions.

Note: CARRY OUT ALL TUNINGS (BASEBAND, RF, UI)!

Display module troubleshooting

General instructions for display troubleshooting
The first step is to verify with a working display that the fault is not on the display module itself. The display
module cannot be repaired.

The second step is to check that the cellular engine is working normally. This can be done by connecting the
phone to a docking station and starting Phoenix service software. With the help of Phoenix read the phone
information to check that also application engine is functioning normally (you should be able to read the APE ID).

After these checks proceed to the display troubleshooting flowcharts. Use the Display Test tool in Phoenix to
find the detailed fault mode.

Operating modes of the display
Display is in a normal mode when the phone is in active use.

Display is in a partial idle mode when the phone is in the screen saver mode.

The operating modes of the display can be controlled with the help of Phoenix.

Table 1 Display module troubleshooting cases

Display blank There is no image on the display. Display looks the
same when the phone is on as it does when the
phone is off. The backlight can be on in some cases.

Image on the display not correct Image on the display can be corrupted or part of the
image can be missing. If part of image is missing
change the display module. If the image is otherwise
corrupted, follow the appropriate troubleshooting
diagram.
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Backlight dim or not working at all Backlight LED components are inside the display
module. Backlight failure can also be in the connector
or in the backlight power source in the main engine
of the phone. Backlight is also controlled
automatically by the ambient light sensor.

This means that in case the display is working (image
OK) but the backlight is not, follow the Display and
keyboard backlight troubleshooting (Page 1–38).

Visual defects (pixel) Pixel defects can be checked by controlling the
display with Phoenix. Use both colours, black and
white, on a full screen.

The display may have some random pixel defects that
are acceptable for this type of display. The criteria
when pixel defects are regarded as a display failure,
resulting in a replacement of the display, are
presented the table below.

Table 2 Pixel defects

Item White dot defect Black dot
defect

Total

1 Defect
counts

R G B White Dot
Total

1 1

1 1 1 1

2 Combined
defect
counts

Not allowed.

Two single dot defects that are within 5 mm of each other should be interpreted
as combined dot defect.

Note: Blinking pixels are not allowed in normal operating temperatures and light conditions.
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Display fault troubleshooting
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Display and keyboard backlight troubleshooting

Context
The device has one LED driver that provides current for both display and keyboard backlights.

Keyboard backlights are turned ON only in dark conditions. This is controlled by the Ambient Light Sensor (ALS).
Also the brightness of the display is adjusted by the ambient light sensor.

You can enable/disable ALS with the help of Phoenix service software.

Display brightness can be adjusted manually, if ALS is disabled. If the ambient light sensor is enabled, it adjusts
the display brightness automatically.
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ALS troubleshooting

Context
• If a phototransistor is broken, replace it with a typical phototransistor.
• The phototransistor has to be also replaced, if calibration values are lost by some other reason (e.g. after

replacing the NOR memory chip D3000).
• If the phototransistor is changed, the calibration value in the phone memory has to be changed to the default

value ‘1’.
• Make sure that you have completed Display and keypad backlight troubleshooting (Page 1–38) first before

starting ALS troubleshooting.

Here are some hints for ALS troubleshooting; the following troubleshooting diagram refers to these:

• Phoenix LED control tool also shows you luminance. The correct luminance in darkness is <20lx, and in office
environment 100-2000lx. The luminance value depends strongly on the light source and the angle of the
phone, so these values are only a rough guideline.

• LED driver control voltage measurement points can be found from LED driver troubleshooting (Page
1–41) section. When backlight brightness is set to 100%, both GENOUT-signals are low, and enable PWM is
100%.

• Phoenix has an ambient light sensor calibration tool for changing calibration values. The pull-up resistor
calibration is done first:

a Cover the light guide (upper part of the A Cover).

b Click Start Write .

c Manually change the ambient light sensor value to the default value. There is no special tool for this, but
you have to perform calibration normally and then set the Co-efficient result to 1 before writing it to the
phone memory.

Figure 16 Ambient Light Sensor Calibration window
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LED driver troubleshooting
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Bluetooth troubleshooting

Introduction to Bluetooth troubleshooting
There are two main Bluetooth problems that can occur:

Problem Description

Detachment of the BT antenna. This would most likely happen if the device has been
dropped repeatedly to the ground. It could cause the
BT antenna to become loose or partially detached
from the PWB. (see the following section for details
on BT antenna HW and mechanics)

Malfunction in the BT ASIC, BB ASICs or Phone’s BT SMD
components.

This is unpredictable and could have many causes
i.e. SW or HW related.

The main issue is to find out if the problem is related to the BT antenna or related to the BT system or the
phone’s BB and then replace/fix the faulty component.

Location of the BT antenna
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Bluetooth test points
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Bluetooth settings for Phoenix

Steps
1. Start Phoenix service software.
2. From the File menu, choose Open Product, and then choose the correct type designator from the Product list.
3. Connect the phone to a docking station in the local mode.
4. Choose Testing →  Bluetooth LOCALS .
5. Locate JBT-9’s serial number (12 digits) found in the type label on the back of JBT-9.
6. In the Bluetooth LOCALS window, write the 12-digit serial number on the Counterpart BT Device Address line.

This needs to be done only once provided that JBT-9 is not changed.
7. Place the JBT-9 box near (within 10 cm) the BT antenna and click Run BER Test.

Results

Figure 17 Phoenix settings for Bluetooth troubleshooting

Bluetooth self tests in Phoenix

Steps
1. Start Phoenix service software.
2. From the File menu, choose Open Product, and then choose the correct type designator from the Product list.
3. Connect the phone to a docking station in the local mode.
4. Choose Testing →  Self Tests .
5. In the Self Tests window check the bluetooth check box.
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6. To run the tests, click Start.

Figure 18 Bluetooth self tests in Phoenix
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Bluetooth troubleshooting
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Bluetooth BER failure troubleshooting
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BT audio failure troubleshooting

Audio troubleshooting

Audio troubleshooting test instructions
Differential external earpiece and internal earpiece outputs can be measured either with a single-ended or a
differential probe.
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When measuring with a single-ended probe each output is measured against the ground.

Internal handsfree output is measured using a current probe, if a special low-pass filter designed for measuring
a digital amplifier is not available. Note also that when using a current probe, the input signal frequency must
be set to 2kHz.

The input signal for each loop test can be either single-ended or differential.

Required equipment
The following equipment is needed for the tests:

• Oscilloscope
• Function generator (sine waveform)
• Current probe (Internal handsfree DPMA output measurement)
• Phoenix service software
• Battery voltage 3.7V

Test procedure
Audio can be tested using the Phoenix audio routings option. Three different audio loop paths can be activated:

• External microphone to Internal earpiece
• External microphone to Internal handsfree speaker
• Internal microphone to External earpiece

Each audio loop sets routing from the specified input to the specified output enabling a quick in-out test. Loop
path gains are fixed and they cannot be changed using Phoenix. Correct pins and signals for each test are
presented in the following table.

Phoenix audio loop tests and test results
The results presented in the table apply when no accessory is connected and battery voltage is set to 3.7V.

Earpiece, internal microphone and speaker are in place during measurement. Applying a headset accessory
during measurement causes a significant drop in measured quantities.

The gain values presented in the table apply for a differential output vs. single-ended/differential input.

Loop test Input terminal Output
terminal

Path
gain [dB]
(fixed)

Input
voltag
e
[mVp-
p]

Different
ial
output
voltage
[mVp-p]

Outpu
t DC
level
[V]

Outp
ut
curre
nt
[mA]

External Mic to External
Earpiece

XMICP and GND HSEAR R P,
HSEAR R N
and GND

-2.9 1000 720 1.2 NA

HSEAR P,
HSEAR N and
GND

XMICN and GND HSEAR R P,
HSEAR R N
and GND

HSEAR P,
HSEAR N and
GND
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Loop test Input terminal Output
terminal

Path
gain [dB]
(fixed)

Input
voltag
e
[mVp-
p]

Different
ial
output
voltage
[mVp-p]

Outpu
t DC
level
[V]

Outp
ut
curre
nt
[mA]

External Mic to Internal
Earpiece

XMICP and GND EarP and GND -4.5 1000 600 1.2 NA

EarN and GND

XMICN and GND EarP and GND

EarN and GND

External Mic to Internal
handsfree

XMICP and GND B2102 pads -5 1000 560 0 25m
A
(calc
.)

XMICN and GND B2102 pads

Internal Mic to External
Earpiece

B2100 (OUT/
GND)

HSEAR R P,
HSEAR R N
and GND

22.7 100 1360 1.2 NA

HSEAR P,
HSEAR N and
GND

HSEAR R P,
HSEAR R N
and GND

HSEAR P,
HSEAR N and
GND
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Measurement data

Figure 19 Single-ended output waveform of the Ext_in_HP_out measurement when earpiece is connected.
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Legend
If a special low-pass filter designed for measuring digital amplifiers is unavailable, the measurement must be

performed with a current probe and the input signal frequency must be 2kHz.

Figure 20 Differential output waveform of the Ext_in_IHF_out out loop measurement when speaker is connected.

Figure 21 Single-ended output waveform of the HP_in_Ext_out loop when microphone is connected.
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Internal earpiece troubleshooting

Before you begin
Familiarize yourself with the Audio troubleshooting test instructions (Page 1–49).
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Internal microphone troubleshooting

Before you begin
Familiarize yourself with the Audio troubleshooting test instructions (Page 1–49).
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IHF troubleshooting

Before you begin
Familiarize yourself with the Audio troubleshooting test instructions (Page 1–49).
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External microphone troubleshooting

Before you begin
Familiarize yourself with the Audio troubleshooting test instructions (Page 1–49).
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External earpiece troubleshooting

Before you begin
Familiarize yourself with the Audio troubleshooting test instructions (Page 1–49).

RM-84/99
Nokia Customer Care BB Troubleshooting and Manual Tuning Guide

Page 1–58 Company Confidential Issue 1
Copyright ©2005 Nokia. All Rights Reserved.

 



Vibra troubleshooting
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Baseband manual tuning guide

Energy management calibration

Before you begin
Energy Management (EM) calibration is performed to calibrate the setting (gain and offset) of AD converters in
several channels (that is, battery voltage, BSI, battery current) to get an accurate AD conversion result.

Hardware setup:

• An external power supply is needed.
• Supply 12V DC from an external power supply to CU-4 to power up the phone.
• The phone must be connected to a CU-4 control unit with a product-specific flash adapter.

Steps
1. Place the phone to the docking station adapter (CU-4 is connected to the adapter).
2. Start Phoenix service software.
3. Choose File →   Scan Product .
4. Choose Tuning →  Energy Management Calibration .
5. To show the current values in the phone memory, click Read, and check that communication between the

phone and CU-4 works.
6. Check that the CU-4 used check box is checked.
7. Select the item(s) to be calibrated.

Note: ADC calibration has to be performed before other item(s). However, if all calibrations are selected
at the same time, there is no need to perform the ADC calibration first.

8. Click Calibrate.

The calibration of the selected item(s) is carried out automatically.

The candidates for the new calibration values are shown in the Calculated values column. If the new
calibration values seem to be acceptable (please refer to the following "Calibration value limits" table),
click Write to store the new calibration values to the phone permanent memory.

Table 3 Calibration value limits

Parameter Min. Max.

ADC Offset -20 30

ADC Gain 12000 14000

BSI Gain 1100 1300

VBAT Offset 2400 2650

VBAT Gain 19000 23000

IBAT (ICal) Gain 7750 12250

9. Click Read and confirm that the new calibration values are stored in the phone memory correctly. If the
values are not stored to the phone memory, click Write and/or repeat the procedure again.

10. To end the procedure, close the Energy Management Calibration window.
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